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이책은플래시에관한책이다.

단지플래시에서프로그래밍작업을하는것이아니라플래시에어떤작업을하

도록 지시하고 어떤 결과가 나오는지 지켜보는 것이다. 이것은 은유나 수사학적인

표현이아니다. 바로프로그래밍에대한철학적인접근이다.

프로그래밍 언어는 컴퓨터에 정보를 보내고 컴퓨터로부터 그 정보를 다시 받아

들이는 데 사용한다. 사람들이 쓰는 언어와 마찬가지로 프로그래밍 언어도 어휘와

문법으로 이루어진다. 프로그래밍 언어를 이용하면 컴퓨터에 어떤 일을 하도록 지

시할 수도 있고 정보를 요청할 수도 있다. 프로그래밍 언어에서는 사용자의 명령을

기다리고 주어진 작업을 처리하며 그에 따르는 응답을 한다. 따라서 프로그래밍을

배우기위해이책을읽는다면플래시와의사소통하는법을배우기위해이책을읽

는다고할수도있다. 그렇다고해서플래시에서영어나불어, 독일어, 중국어 같은

언어를 사용하는 것은 아니다. 플래시의 모국어는 액션스크립트이며, 이제 우리가

배우고자하는언어가바로액션스크립트이다.
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컴퓨터언어를배운다는것은종종프로그래밍을배우는것과같은의미로쓰인

다. 하지만프로그래밍은단순히언어의구조를배우는것이상의작업이다. 플래시

에서 우리말을 사용한다면 어떨까? 만약 플래시와 의사소통하기 위해 액션스크립

트를따로배우지않아도된다면말이다.

만약“플래시, 화면에공이튀어다니게해봐”라고말한다면어떻게될까?

플래시에서는 우리의 요청을 제대로 처리하지 못할 것이다. ‘공’이라는 단어를

이해하지 못하기 때문이다. 이러한 문제는 사실 말뜻을 이해하는 문제에 지나지 않

는다. 플래시는 사람들이 플래시가 알고 있는 객체(무비 클립, 버튼, 프레임과 같은

것)를이용하여설명하기를원한다. 그렇다면이제플래시가알아들을수있는말로

고쳐서 플래시에 명령을 내려보자. “플래시, ball_one이라는 무비 클립을 화면에서

돌아다니게만들어봐.”

하지만 이렇게 한다고 해서 플래시에서 우리의 요청을 처리해줄 리가 없다. 공

의 크기가 어느 정도 되어야 할까? 또 공의 위치는 어디쯤이 좋을까? 처음에 어느

방향으로움직여야할까? 속도는? 화면의어느부분에서공이반사되어야할까? 그

리고 얼마나 오랫동안 움직여야 하나? 2차원으로 움직일까, 3차원으로 움직일까?

흠... 이러한질문은우리가예상하고있던것은아니다. 물론플래시에서진짜이러

한질문을하지는않는다. 우리의요청을이해하지못하는경우에는그요청을처리

하지않거나오류메시지를내보낼뿐이다. 일단플래시에서조금더직설적으로지

시해달라는요청을했다고가정하고우리의요청을몇가지단계로재구성해보자.

1. 공은 ball이라는이름을가진원모양의무비클립이다.

2. 직사각형은 square라는이름을가진사각형모양의무비클립이다.

3. 지름이 50픽셀인녹색공을새로만든다.

4. 새로운공을 ball_one이라고부른다.

5. 너비가 300픽셀인새로운검은직사각형을만들어스테이지중앙에놓는다.

6. ball_one은직사각형맨윗부분에놓는다.

7. ball_one을초당 75픽셀의속도로임의의방향으로움직인다.

8. ball_one이직사각형의변에부딪히면반사시킨다.

9. 정지명령을내릴때까지계속움직인다.
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모두 우리말로 설명하긴 했지만 플래시에 우리의 뜻을 이해시키려면 화면 위에

서 튀어 다니는 공을 논리적으로 설명해야 한다. 물론 프로그래밍이 단순히 프로그

래밍 언어의 구조에 불과한 것은 아니다. 우리말과 마찬가지로 단어를 많이 안다고

해서말을잘할수있는것은아니다.

지금까지 가상적으로 우리말을 알아듣는 플래시 예제를 생각해 보았는데, 여기

서반드시알아야할프로그래밍의중요한네가지요소를짚고넘어가자.

䤎 어떤 언어를 사용하든지 프로그래밍의 진수는 논리적인 단계를 체계적으로

서술하는데있다.

䤎 컴퓨터 언어로 무엇인가를 말하기 전에 우선 우리말로 어떤 명령을 내릴지

생각해보는것이좋다.

䤎 한 언어에서 쓰이는 문장을 다른 언어로 옮기더라도 결국 기본적인 구문은

그대로남게된다.

䤎 컴퓨터는 가정하는 데 그다지 능숙하지 않으며, 어휘도 상당히 제한되어

있다.

대부분의 프로그래밍 과정은 코드를 작성하는 것과는 전혀 상관이 없다. 단 한

줄의액션스크립트코드를짜더라도만들려고하는것이정확히무엇인지생각해보

고 시스템의 기능을 순서도나 청사진으로 미리 만들어야 한다. 개념적인 수준에서

프로그램이완벽하다고생각되면그때액션스크립트로그생각을옮기면된다.

사랑이나 정치, 비즈니스와 마찬가지로 프로그래밍에서도 효율적인 의사소통이

성공의 열쇠가 된다. 플래시에서 독자가 만든 액션스크립트를 이해하려면 따옴표,

등호, 세미콜론과같은사소한부분까지문법을정확하게맞추어야한다. 또한프로

그래머의 의도를 정확하게 전달하려면 플래시에서 알 수 있는 표현만을 이용하여

플래시 세계에 있는 것만을 이야기해야 한다. 컴퓨터 프로그래밍을 어린 아이에게

말하는 것과 같다고 생각해보자. 어떤 것도 당연하게 여기지 말고 자세한 내용까지

직접말해야하고하나의작업을완료하기위해필요한모든단계를가르쳐줘야한

다. 하지만플래시는어린아이와는달리시키는일을정확하게처리하고시키지않

은일은전혀하지않는다는것을기억해두자.
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몇 가지 기본 문장
어떤 언어를 배우든지 첫날에는 아주 간단한 문장을 배운다(“안녕하세요”같은

것). 각단어의의미를정확하게알지못한채로문장을통째로외운다고해도그문

장의의미와그러한뜻을전달할때같은문장을반복하면된다는것은알수있다.

일단 문법규칙을배우고어휘를늘리고외우고있는문장을응용하여다양한단어

를 사용하다 보면, 처음에 배운 문장을 더 깊이 이해할 수 있다. 이 장에서는 이제

외국어학교에서첫날하는것과마찬가지로코드의일부분을살펴보고몇가지기

본 문법을 배우게 될 것이다. 그리고 나서 이 책의 나머지 부분에서는 기본 문법을

바탕으로더복잡한것을배우게된다. 이 책을 모두읽고나서 1장을다시읽어보

면얼마나많은것을배웠는지새삼느낄수있을것이다.

코드 작성

첫째 예제로 플래시 무비에 네 줄 짜리 간단한 코드를 추가하는 법을 배워보자.

거의 모든 액션스크립트 프로그래밍은 액션 패널(Actions panel)에서 이루어진다.

플래시 무비를재생할때플래시에서는액션패널에있는모든지시사항을수행한

다. 다음과같이액션패널을열어보자.

1. 플래시를시작하고새문서를만든다.

2. 메인타임라인에서레이어 1의프레임 1을선택한다.

3. Window → Actions를선택한다.

액션패널은스크립트틀(Script pane, 오른쪽부분)과도구상자틀(Toolbox pane,

왼쪽부분)로나뉜다. 스크립트틀에는모든코드가들어간다. 도구상자틀을이용하

면 액션(Action), 연산자(Operator), 함수(Function), 속성(Property), 그리고 액션스

크립트객체(Object)를 쉽게이용할수있다. 이전버전에서이미 [그림 1-1]에 나온

것과같은 Basic Actions 메뉴를많이보았을것이다.

하지만도구상자틀에는더많은기능이들어있다. [그림 1-2]에 플래시 2, 3이

나 4에서부터 사용하던 것이 포함된 모든 액션이 나와 있다. 도구상자 틀을 살펴보

면사운드(Sound), 배열(Array), XML 같은것도들어있다. 이 책을끝마치고나면

이러한내용을모두익힐수있을것이다.
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[그림 1-1] 플래시 5의 Basic Actions

[그림 1-2] Actions 메뉴를 확장한 모습



도구상자 틀의 메뉴를 이용하여 액션스크립트 코드를 만들 수도 있다. 하지만

구문이나 원리, 액션스크립트의 전반적인 구조를 배우고자 한다면 코드를 직접 입

력하는것이좋다.

이 책에서는 액션을 프로그래머 입장에서 여러 분야로 나눌 것이다. 상황에 따

라액션을적절한프로그래밍용어로설명한다. 예를들면‘while 액션을추가한다’

라는 표현 대신‘while 순환문을 만든다’라고 하거나, ‘if 액션을 추가한다’대신

‘새로운 조건문을 만든다’라고 하거나, 또는‘play 액션을 추가한다’대신‘play()

함수(또는 메소드)를 호출한다’라는 표현을 사용할 것이다. 이처럼 각 요소를 정확

하게분류하는것은액션스크립트를배우는데매우중요한부분이다.

이제준비가되었다면프로그래밍을시작해보자.

플래시에 인사하기

액션틀에코드를입력하기전에다음과같이액션스크립트의자동입력기능을

해제해야한다.

1. Edit → Preferences 선택

2. General 탭에서 Actions Panel 선택→ Mode → Expert Mode

3. 액션 패널의 맨 오른쪽에 있는 화살표를 누르면 나타나는 팝업 메뉴에서

Expert Mode를 선택해도 되지만 이렇게 하면 현재 작업 중인 프레임의 모

드만변경된다(‘16장. 액션스크립트저작환경’참조).

전문가 모드(Expert Mode)로 바꿔놓고 나면 이미 전문가가 된 기분이 들 것이

다. 전문가 모드로 들어가면 액션 패널 아래 부분에 있는 인자 틀(Parameter pane)

이 없어진다. 하지만 메뉴를 이용하여 프로그래밍을 하지 않는다면 걱정하지 않아

도된다.
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액션이라는 것은 단순히 어떤 동작만을 나타내는 것은 아니다. 액션에는 변수, 조건문, 순환
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이제레이어 1의프레임 1을선택하자. 액션스크립트(즉코드)는 반드시프레임이

나 무비 클립, 또는 버튼에 연결되어 있어야 한다. 프레임 1을 선택하면 새로 만드는

코드가그프레임에연결된다. 전문가모드에서는액션패널오른쪽에있는스크립트

틀에직접입력하면된다. 앞으로계속이러한방식으로프로그램을입력할것이다.

이제 첫째 프로그램을 만들어보자. 플래시에 간단한 인사말을 전달하는 프로그

램이다. 스크립트틀에다음과같은코드를입력하자.

var message = "Hi there, Flash!";

위와같은한줄의코드만으로도완벽한하나의명령, 즉 선언문이성립된다. 그

밑에이문단아래에나와있는코드를추가해보자. your name here 부분에는독자

의이름을적당히집어넣으면된다(코드 중에서이탤릭체로표시된부분은독자가내

용을입력하는부분이다).

var firstName = "your name here";

trace (message);

하지만 이렇게 한다고 해도 아직 특별한 결과가 나타나지는 않는다. 이 코드를

.swf 파일로 저장하고 무비를 재생하기 전에는 이 코드가 실행되지 않기 때문이다.

그 전에 플래시에서 우리의 인사에 적당한 응답을 할 수 있도록 해보자. 코드의 마

지막줄에다음과같이한줄을추가하면된다.

trace ("Hi there, " + firstName + ", nice to meet you.");

이제우리의첫프로그램을실행해볼때가되었다. Control → Test Movie를선

택한다음, 어떤결과가나오는지지켜보자. [그림 1-3]과 같이텍스트가화면에나

타날것이다.

신기하지않은가? 이제위프로그램이어떻게동작하는지알아보자.
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변수

프로그래밍이라는것은컴퓨터와의사소통하는것에불과하다고말했던것을아

마기억하고있을것이다. 물론그렇긴하지만컴퓨터는보통사람과는약간성격이

다르다. 첫줄에있는코드에서실제로플래시에게인사를하는것은아니다.

var message = "Hi there, Flash!";

위선언문을설명하자면다음과같다.

플래시, “Hi there, Flash!”라는 정보를 기억해 줘. 나중에 써야 될지도 모르니까 message

라는 이름을 붙이기로 하지. 나중에 message라는 것을 찾으면“Hi there, Flash!”라는 문

장을돌려주면돼.

그냥‘안녕’하고인사하는것처럼쉽지는않지만, 이러한선언문이바로프로그

래밍의 기반이 된다. 플래시에서는 나중에 필요할 때 부르기 위한 이름만 붙여준다

면 그 내용을 기억할 수 있다. 예를 들어 둘째 줄에서는 플래시에서 독자의 이름을

기억하도록 하고 그 내용을 firstName이라고 부르도록 만들었다. 플래시에서는 이

렇게미리독자의이름을기억해두고있다가무비를테스트할때출력윈도우에내

보낸다.

독자에게필요한변수를저장할수있다는것은프로그래밍에서매우중요하다.

플래시에서는텍스트(이름같은것), 숫자(3.14159 같은것) 및 앞으로배울여러가

지복잡한데이터형도저장할수있다.

플래시에서 대상을 기억하는 법에 대한 몇 가지 형식적인 용어를 배워보자. 플

래시에서정보를기억할수있다는것은이미배웠다. 각각의정보를데이터라고부

른다. 데이터(예를 들면“Hi there, Flash!”와 같은 것)와 그 데이터를 가리키는레이

블(예를들면 message 같은것)을 합쳐서‘변수(variable)’라고부른다. 변수의레이

블은‘이름(name)’이라고부르고변수의데이터를‘값(value)’이라고부른다. 또한

‘변수에값을저장한다’, 또는‘변수에어떤값이들어있다’라는표현을사용한다.
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“Hi there, Flash!”는그값이문자열또는텍스트라는것을나타내기위해큰따옴표

로묶여있다는점에유의하자.

우리가처음작성한코드에서 message라는변수값을지정하였다. 변수값을지

정하는 것을‘변수 값 대입’, 또는‘대입’이라고 부른다. 하지만 변수에 값을 대입

하기전에우선변수를만들어야한다. 변수를만들때는앞에서본것처럼 var라는

특별한키워드를이용하여변수를선언하면된다.

한 예로, 앞에서 만든 코드를 방금 설명한 용어들을 이용하여 설명해 보자.

message라는이름의새변수를선언하고그변수에“Hi there, Flash!”라는초기값

을대입하면다음과같이쓸수있다.

var message = "Hi there, Flash!";

무대 뒤의 마법사(인터프리터)

처음에만들었던코드를다시떠올려보자.

var message = "Hi there, Flash!";

var firstName = "your name here";

위에 있는 두 개의 선언문에서 각각 하나의 변수를 만들고 그 변수에 값을 대입

하였다. 하지만셋째와넷째줄은약간다르다.

trace (message);

trace ("Hi there, " + firstName + ", nice to meet you.");

이 선언문에서는 trace() 명령어를 사용한다. 이 명령어는 이미 실행해 봐서 알

겠지만플래시에서 Output 창에텍스트를출력하도록하는역할을한다. 셋째줄에

서는 message라는 변수 값을 화면에 표시한다. 마지막 줄에서는 firstName이라는

변수를 그 변수에 입력된 값으로 바꾸고“Hi there”라는 문장 바로 뒤에 그 문장을

집어넣는다. 그리고나서 trace() 명령어에서는주어진데이터를 Output 창에출력

하는작업을 처리한다(Output 창은프로그램실행도중에어떤일이일어나는지알아

보는데사용하면편리하다).
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그런데 trace() 명령에서는 어떻게 Output 창에 텍스트를 출력시킬까? 어떤 명

령을 내리는 것은 곧 액션스크립트 인터프리터에 명령을 내리는 것이며, 액션스크

립트 인터프리터는 프로그램을 실행시키고 코드를 관리하고 명령이 들어오는지 감

시하며, 액션스크립트 명령을 수행하고 선언문을 실행하고 데이터를 저장하며, 사

용자에게 정보를 전달하고 값을 계산하고 플래시 플레이어에서 무비를 로딩할 때

기본적인프로그래밍환경을구축하는작업도처리한다.

인터프리터는액션스크립트를컴퓨터에서이해할수있는언어로번역하고코드

에 주어진 대로 작업을 수행한다. 무비를 재생하는 도중에 인터프리터는 항상 활성

화된상태로사용자의명령을받아들인다. 인터프리터에서사용자의명령을이해할

수있다면그명령은컴퓨터의 CPU로전달되어실행된다. 명령을통해어떤결과가

만들어지면인터프리터는그결과를사용자에게전달한다. 만약인터프리터에서명

령을 이해할 수 없는 경우에는 오류 메시지를 내보낸다. 따라서 인터프리터는 사용

자의 명령을 기다리는 역할도 하고 플래시에서 나오는 정보를 사용자에게 다시 전

달하는대표자역할도한다.

인터프리터의작동방법을자세히알아보기위해간단한 trace() 명령을 처리하

는방법을살펴보자.

다음과같은명령을인터프리터에서어떻게다룰지생각해보자.

trace ("Nice night to learn ActionScript.");

인터프리터에서는 미리 정해진 명령어 이름 목록에서 trace라는 키워드를 바로

감지한다. 또한 trace()가 Output 창에 텍스트를 표시하는 데 쓰인다는 것을 이미

알고있기때문에, 어떤텍스트를화면에표시할지알아내려고한다. 그러므로 trace

라는단어뒤에오는괄호사이에들어있는“Nice night to learn ActionScript”라는

문장을찾아내고“아, 나한테필요한문장이바로이거구나. Output 창으로이문장

을보내야겠다”라고생각한다.

명령어는 세미콜론(;)으로 끝난다는 점을 기억해 두자. 세미콜론은 문장 맨 뒤

에 있는 마침표에 해당한다. 몇 가지 예외를 제외하면 모든 액션스크립트 선언문은

세미콜론으로 끝난다. 선언문을 제대로 이해하고 필요한 정보를 갖추고 나면 인터

프리터에서는명령을번역하고 CPU에전달하여 Output 화면에텍스트가나타나도

록처리한다.
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설명하다 보니 인터프리터와 CPU에서 일어나는 일을 너무 심하게 단순화하긴

했지만, 다음과같은요점은확인할수있다.

䤎 인터프리터에서는언제나사용자의명령을기다린다.

䤎 인터프리터에서는사용자의코드를한글자씩읽어들이고그명령을이해하

려고 한다. 사람이 책을 읽을 때 책에 있는 문장을 이해하려고 하는 과정과

똑같다고보면된다.

䤎 인터프리터에서는 사용자가 만든 액션스크립트를 읽어들일 때 엄격한 규칙

을적용한다. 예를들어 trace() 선언문에서괄호가빠져있다면인터프리터

에서는그문장을이해할수없기때문에명령을제대로수행할수없다.

인터프리터에 대해 전혀 몰랐던 독자도 있겠지만 머지 않아 애인과 함께 있는

것만큼 인터프리터가 편하게 느껴질 것이다. 싸울 일도 많고 소리지를 일도 많겠지

만(“왜 내얘기를제대로듣지않는거지?”)... 서로를 완벽하게이해할수있다면행

복한 일도 많을 것이다. 조금 이상하게 들릴지 모르지만 필자의 아버지는 외국어를

배우려면그언어를사용하는외국인을사귀는게제일좋다고말씀하곤하셨다. 그

러한점에서필자는여러분이액션스크립트인터프리터와좋은관계를유지하길바

란다. 이제부터는 액션스크립트 명령이 수행되는 과정을 설명할 때 플래시 대신 인

터프리터라는용어를자주사용할것이다.

추가 정보(인자)

이미 앞에서 trace() 명령어를 사용할 때 인터프리터에 화면에 표시할 텍스트를

전달하는 경우를 보았다. 이러한 방법은 일반적으로 많이 쓰이는 방법이다. 앞으로

인터프리터에명령을내릴때그명령을실행하기위해필요한보조데이터를전달하

는 일이 많을 것이다. 명령어와 함께 보내는 데이터는‘인자(argument, parameter)’

라고부른다. 명령어에인자를제공하려면그인자를괄호안에집어넣으면된다.

command(argument);

하나의명령어에여러인자를전달할때는쉼표(,)를이용하여분리한다.

command(argument1, argument2, argument3);
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명령어에 인자를 제공하는 것을 보통 인자를 전달한다고 한다. 예를 들어

gotoAndPlay(5)라는 코드에서 gotoAndPlay는 명령어 이름이고 5는 그 명령으로

전달되는 인자이다(이 경우에는 프레임 번호를 가리킨다). stop()과 같은 몇몇 명령

어에는괄호가필요하지만인자를받아들이지는않는다. ‘9장. 함수’에서그이유를

알아보기로하자.

액션스크립트용 풀(연산자)

다음과 같은 trace() 선언문이 있는 처음에 다루었던 코드의 넷째 줄을 다시 살

펴보자.

trace ("Hi there, " + firstName + ", nice to meet you.");

여기서 덧셈 기호(+)를 사용한다는 점에 유의하자. 이 기호는 텍스트를 합치는

데 쓰이는 연산자로 액션스크립트에서 많이 쓰이는 연산자 중 하나이다. 프로그래

밍언어에서쓰이는연산자는사람들이사용하는언어에서접속사(그리고, 또는, 하

지만 등)와 비슷하다. trace() 예제에서는 덧셈 기호를 이용하여“Hi there”와

firstName에들어있는텍스트를합친다.

모든 연산자는 코드 구문을 합치고 그 과정에서 구문을 조작하는 역할을 한다.

그 구문이 텍스트이거나 숫자, 또는 다른 데이터형인 경우에도 연산자는 일종의 변

환작업을수행한다. 덧셈연산자와마찬가지로많은연산자에서두가지대상을합

치는 작업을 처리한다. 하지만 값을 비교하거나 대입하고 논리적인 결정을 내리고

데이터형을 알아내거나 새로운 객체를 만드는 것과 같은 다양한 작업을 처리하는

연산자도많이있다.

두개의숫자피연산자와함께사용하면덧셈기호(+)와뺄셈기호(-)를 이용하

여 간단한 산수 계산을 처리할 수 있다. 다음과 같은 명령을 내리면“3”이 Output

창에출력된다.

trace(5 - 2);

< 연산자는두개의수중에서어느쪽이더큰지, 또는 두 분자중에서어느쪽

이알파벳순으로더앞에있는지알아내는데쓰인다.
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if (3 < 300) {

// 어떤 작업을 처리한다.

}

if ("a" < "z") {

// 다른 작업을 처리한다.

}

조합, 비교, 대입과 같이 연산자를 통해 이루어지는 조작을‘연산’이라고 부른

다. 수식 연산은 덧셈(+), 뺄셈(-), 곱셈(*), 나눗셈(/)과 같이 산수 시간에 배우는

규칙을 그대로 따르기 때문에 제일 이해하기 쉽다. 하지만 전문적인 프로그래밍 작

업에만쓰이는연산자는조금생소할수도있다. 예를들어 typeof 연산자를생각해

보자. 이 연산자는변수에어떤종류의데이터가들어있는지알려주는역할을한다.

만약 x라는 변수를 만들어서 4를 대입한 후에 x의 데이터형을 알고 싶다면 다음과

같이하면된다.

var x = 4;

trace (typeof x);

플래시에서 이 코드를 실행하면 Output 창에“number”라는 단어가 출력된다.

typeof 연산자를 사용할 때에도 피연산자는 필요하지만 그 변수를 괄호 안에 집어

넣지는않고그냥 typeof x 라고하는것을기억해두자. 이렇게되면 x가 typeof의

인자인지 아닌지 궁금할 것이다. 사실 x는 인자(코드 구문을 계산하기 위해 필요한

보조데이터)와똑같은역할을하긴하지만연산자의개념에서본다면 x는공식적으

로 피연산자라고 부르는 것이 옳다. 피연산자는 연산자가 연산을 수행할 대상이 되

는아이템을가리키는말이다. 예를들어 4 + 9라는수식에서 4와 9라는숫자는+

연산자의피연산자가된다.

액션스크립트에서 쓰이는 연산자에 관한 것은‘5장. 연산자’에서 자세히 다룰

것이다. 일단연산자가몇가지변환과정에서코드구문을이어주는역할을한다는

것을기억해두자.
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모두 합치기

지금까지배운것을다시훑어보자. 다시첫줄을살펴보자.

var message = "Hi there, Flash!";

여기에서 var라는 키워드는 새로운 변수를 선언한다는 것을 인터프리터에 알려

준다. message라는단어는변수의이름이다. 등호연산자에서는텍스트문자열(“Hi

there, Flash!”)을 message라는변수에대입한다. 따라서“Hi there, Flash!”라는텍

스트가 message 값이 된다. 마지막으로 세미콜론(;)은 첫째 선언문이 끝났다는 것

을인터프리터에알려주는역할을한다.

둘째줄은첫째줄과거의비슷하다.

var firstName = "your name here";

여기서 your name here 자리에 입력한 텍스트를 firstName이라는 변수에 대입

한다. 세미콜론으로둘째선언문이끝났다는것을표시한다.

그리고나서셋째, 넷째줄에서는 message와 firstName 변수를사용한다.

trace (message);

trace ("Hi there, " + firstName + ", nice to meet you.");

trace라는 키워드는 인터프리터에 Output 창으로 텍스트를 표시하고 싶다는 것

을 알려주는 역할을 한다. 이 때 출력하고자 하는 텍스트를 인자로 전달한다. 왼쪽

괄호는인자의시작부분을가리킨다. 넷째줄에서는인자에두개의연산이포함되

어 있으며 두 연산 모두 덧셈 기호를 연산자로 사용한다. 첫째 연산에서는 첫째 피

연산자인“Hi there,”와 둘째 피연산자인 firstName을 합친다. 둘째 연산에서는 첫

째연산에서나온결과에“, nice to meet you.”를 덧붙인다. 오른쪽괄호로인자의

끝부분을나타내며세미콜론을이용하여선언문의끝을나타낸다.
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액션스크립트 심화 개념
지금까지 데이터, 변수, 연산자, 선언문, 함수, 인자와 같은 액션스크립트를 이

루는 몇 가지 기본 요소를 알아보았다. 이러한 주제를 더 깊이 다루기 전에 액션스

크립트의나머지핵심기능에대해간단히알아보자.

플래시 프로그램

대부분의 사용자는 프로그램을 어도비 포토샵이나 매크로미디어 드림위버 같은

애플리케이션이라고 생각한다. 하지만 플래시에서 애플리케이션을 만들지는 않는

다. 프로그래머들은 프로그램을 코드의 모음(일련의 선언문)이라고 정의하지만 그

러한정의는우리가하는일의일부분에지나지않는다.

플래시무비는단순한코드의모음이아니다. 플래시코드는프레임이나버튼과

같은플래시무비의기본요소와연결되어있다. 우리는그러한요소에코드를추가

하여서로상호작용할수있도록해주는작업을한다.

결국‘프로그램’을고전적인의미로본다면플래시에는프로그램이라는것이없

다. 프로그램을 모두 액션스크립트를 이용하여 만드는 것이 아니라 스크립트를 사

용할뿐이다. 마치 HTML 문서에자바스크립트를이용하여프로그램과같은성질을

부여하는 것처럼 무비에 액션스크립트를 이용하여 프로그램과 같은 성질을 부여한

다고보면된다. 우리가실제로만드는것은프로그램이아니라 (코드, 타임라인, 비

주얼, 사운드및기타요소가포함된) 무비이다.

스크립트에는 C++나자바에서화면에그래픽을표시하거나사운드큐를저장하

기위해사용하는운영체제수준의코드를제외하면전통적인프로그램에서사용하

는 거의 모든 요소가 포함된다. 스크립트를 이용하면 그래픽 및 사운드 프로그래밍

을관리하지않아도되므로무비의속성을설계하는것에만집중하면된다.

표현식

앞에서배운것처럼스크립트의선언문에는스크립트명령어가들어있다. 하지

만대부분의명령어는데이터가없으면아무런쓸모가없다. 예를들어변수를설정

할때변수값에해당하는어떤데이터를대입해야하는것처럼말이다. trace() 명
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령을이용할때는 Output 창에출력할데이터를인자로전달한다. 데이터는우리가

액션스크립트코드에서조작할내용물이다. 스크립트전반에걸쳐수많은데이터를

읽어들이고내보내고저장하고여기저기로이동하게될것이다.

프로그램이실행될때하나의데이터를만들어내는구문을‘표현식(expression)’

이라고부른다. 7이라는숫자, 또는“제웹사이트에오신것을환영합니다”같은문

자열은모두간단한표현식에해당한다. 이 두표현식은프로그램이실행될때있는

그대로 쓰이는 간단한 데이터를 나타낸다. 따라서 이러한 표현식은‘리터럴 표현식

(literal expression)’또는간단하게‘리터럴(literal)’이라고부른다.

리터럴은여러가지표현식중하나일뿐이다. 변수도표현식이될수있다(변수

는데이터를나타내기때문에표현식이라고볼수있다). 표현식을연산자로합치면더

특이한모양이나올수도있다. 예를들어 4+5라는표현식은두개의피연산자(4와

5)가 있는 표현식이지만 덧셈 연산자가 있기 때문에 전체적으로 9라는하나의 값을

갖는표현식이된다. 코드전체를하나의값으로변환할수만있다면복잡한표현식

에다른짧은표현식을포함시킬수도있다.

다음과같은변수 message를생각해보자.

var message = "Hi there, Flash!";

원한다면 다음과 같이 변수 표현식인 message를“How are you?”라는 리터럴

표현식과합칠수도있다.

message + "How are you?"

이렇게 하면 프로그램이 실행될 때 이 표현식 값은“Hi there, Flash! How are

you?”가된다. 수식계산을하다보면긴표현식에짧은표현식이포함되어있는것

을자주볼수있다.

(2 + 3) * (4 / 2.5) - 1

프로그래밍 개념을 설명할 때 표현식이라는 용어를 자주 사용하기 때문에 프로

그래밍을 배우는 과정에서 표현식을 일찌감치 알아두는 것이 좋다. 예를 들어 필자

가‘변수에값을대입하려면변수이름, 등호, 임의의표현식을차례로입력하면된

다’라는식으로설명하는경우가적지않게있을것이다.
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두 가지 필수 선언문 유형 : 조건문과 순환문

‘조건문(conditional)’과‘순환문(loop)’은 각각 논리적인 작업과 반복 작업을

처리하는데쓰이기때문에거의모든프로그램에서사용된다.

플래시 프로그래밍의 가장 뛰어난 점은 무비를 더 똑똑하게 만들 수 있다는 것

이다. 여기에서 똑똑하다는 말은 다음과 같이 설명할 수 있다. 웬디라는 여학생이

옷이젖는것을좋아하지않는다고가정하자. 웬디가매일아침집에서나오기전에

그녀는창문을열어서날씨를확인해본다. 만약비가내리면그녀는우산을가지고

나간다. 그러면 웬디는 똑똑하다고 말할 수 있다. 그녀는 기본적인 논리(일련의 선

택사항을살펴보고주어진상황을기반으로무엇을할지결정하는것)를 이용할 줄 안

다. 상호작용할수있는플래시무비를만들때도똑같은기본논리를이용한다.

플래시무비에서논리의예는다음과같다.

䤎 무비에세개의섹션이있다고가정하자. 사용자가각섹션에들어가면논리

를이용하여그섹션의도입부를보여줄지결정한다. 사용자가전에그섹션

에 들어가 본 적이있다면 도입부를건너뛰고 그렇지 않다면 도입부를 보여

준다.

䤎 무비에서 제한 구역이 있다고 가정하자. 그 제한 구역에 들어가려면 사용자

가암호를입력해야한다. 사용자가정확한암호를입력하면그내용을보여

준다. 그렇지않으면보여주지않는다.

䤎 화면위에서공이움직일때벽에서반사되도록한다고가정하자. 공이정해

진 점을 지나면 공의 방향을 반대로 돌린다. 그렇지 않으면 공이 원래 움직

이던방향으로계속움직이도록한다.

무비에 논리를 적용하려면 조건문이라는 특별한 형태의 선언문을 사용해야 한

다. 조건문을 이용하여 어떤 부분의 코드를 실행시키거나 실행시키지 않을 조건을

지정할수있다. 조건문의예는다음과같다.

if (userName == "James Bond") {

trace ("Welcome to my web site, 007.");

}
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조건문의일반적인구조는다음과같다.

if (조건) {

실행해야 할 코드
}

자세한문법은‘7장. 조건문’에서배울수있다. 일단조건문을이용하여플래시

에서논리적인결정을내릴수있다는점만기억하고넘어가자.

무비에서논리적인결정을내리는것외에사람대신지루한반복작업을처리하

는 것도 필요하다. 그러니까 컴퓨터가 온 세계를 집어삼키고 사람을 노예로 만들어

서 조그만 에너지 주머니에 넣고 부려먹기 전까지는... 잠깐... 방금 말한 것은 잊어

주기바란다. 흠... 특정숫자부터시작해서다섯개의연속된숫자를 output 창에출

력한다고가정하자. 시작하는숫자가 10이라면수열을다음과같이출력할수있다.

trace (10);

trace (11);

trace (12);

trace (13);

trace (14);

하지만그수열을 513부터시작하려면모든숫자를다음과같이고쳐야한다.

trace (513);

trace (514);

trace (515);

trace (516);

trace (517);

trace() 선언문과변수를함께사용하면일일이다시입력하지않아도된다.

var x = 1;

trace (x);

x = x + 1;

trace (x);

x = x + 1;

trace (x);

x = x + 1;
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trace (x);

x = x + 1;

trace (x);

첫 줄에서 변수 x의 값을 1로 설정하였다. 그리고 둘째 줄에서 그 값을 Output

창으로보낸다. 셋째줄에서는 x의현재값을읽어들여그값에 1을더하고그결과

를 변수 x에 다시 대입한다. 따라서 x 값은 2가 된다. 그리고 x 값을 다시 Output

창으로 보낸다. 이 과정을 세 번 더 반복한다. 이 작업을 마치고 나면 Output 창에

다섯개의연속적인숫자가출력된다. 이렇게하면수열을시작하는숫자를바꿀때

x의초기값만변경하면된다는장점이있다. 나머지코드는 x를기반으로돌아가기

때문에프로그램이실행될때모든숫자가자동으로바뀐다.

이 방법은 처음 방법보다는 더 발전된 방법이며, 다섯 개의 숫자만 출력할 때는

그럭저럭 쓸만하다. 하지만 500개 정도의 숫자를 출력할 때는 그다지 쓸모가 없다.

여러 번 반복되는 작업을 수행하려면 순환문(코드 블록이 임의의 횟수만큼 반복되도

록하는선언문)을이용하면된다. 순환문에는몇가지종류가있으며각순환문마다

문법이 조금씩 다르다. 가장 흔하게 쓰이는 것으로 while 선언문이 있다. 선언문을

반복해서 사용하는 대신 while 루프를 이용하면다음과 같이간단하게 작업을 처리

할수있다.

var x = 1;

while (x <= 5) {

trace (x);

x = x + 1;

}

while이라는키워드는순환문이시작된다는것을나타낸다. (x <= 5)라는 표현

식은 순환문을 반복해야 할 횟수를 결정한다(x가 5 이하면 계속 코드를 실행한다).

trace (x); 와 x = x + 1;은 순환문이반복되는동안매번실행된다. 앞의 두코드

를단순하게비교한다면겨우다섯줄밖에줄어들지않았지만더많은숫자를출력

할 경우에는 수백 줄을 줄일 수도 있다. 또한 순환문은 매우 유연하다. 순환문에서

500까지 숫자를 출력하려고 한다면 간단히 (x <= 5)를 (x <= 500)으로 고치기만

하면된다.
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var x = 1;

while (x <= 500) {

trace (x);

x = x + 1;

}

조건문과마찬가지로순환문은프로그래밍에서가장많이쓰이면서중요한선언

문이다.

모듈화된 코드(함수)

지금까지는제일긴스크립트가네줄짜리였다. 하지만머지않아네줄이아니라

400줄또는 4,000줄짜리코드를만들게될것이다. 조만간코드를손쉽게관리할수

있으며작업량을줄이고여러가지상황에적용하기좋은코드를만들수있는방법

을찾아야할것이다. 그 때 쯤이면‘함수(function)’가 반드시 필요하다. 함수는 패

키지화된일련의선언문이다. 보통함수는재사용할수있는코드블록역할을한다.

다섯 개의 사각형 넓이를 계산하는 코드를 만들어보자. 아래에서 볼 수 있듯이

사각형한개의넓이를계산하는코드의다섯배분량의코드가필요하다.

var height1 = 10;

var width1 = 15;

var area1 = height1 * width1;

var height2 = 11;

var width2 = 16;

var area2 = height2 * width2;

var height3 = 12;

var width3 = 17;

var area3 = height3 * width3;

var height4 = 13;

var width4 = 18;

var area4 = height4 * width4;

var height5 = 20;

var width5 = 5;

var area5 = height5 * width5;
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넓이 계산을 계속 반복해야 하므로 하나의 함수에 모든 기능을 집어넣고 그 함

수를여러번실행하는것이좋다.

function area(height, width){

return height * width;

}

area1 = area(10, 15);

area2 = area(11, 16);

area3 = area(12, 17);

area4 = area(13, 18);

area5 = area(20, 5);

우선 var를 이용하여 변수를 선언하듯이 function 선언문을 이용하여 넓이를 계

산하는 함수를 만들었다. 그리고 변수 이름을 붙이는 것과 마찬가지로 함수에 area

라는 이름을 부여한다. 괄호 사이에는 함수를 사용할 때마다 함수에서 받아들여야

하는인자의목록(height, width)을 집어넣는다. 그리고나서중괄호({ }) 안에는함

수에서실행해야할선언문을포함시킨다.

return height * width;

함수를 만든 후에는 무비 안에 있는 모든 위치에서 그 이름만을 이용하여 함수

안에있는코드를실행시킬수있다. 앞에서사용한예제에서는 area() 함수를다섯

번 호출하였으며, 각각 높이와 너비 값(height와 width)을 인자로 전달하였다

(area(10, 15), area(11, 16) 등). 각계산결과는사용자에게리턴되며그값은 area1

부터 area5까지변수에저장된다. 함수를사용하지않는버전의코드에비하면훨씬

적은작업량으로깔끔하고멋지게작업을처리할수있다.

이 함수 예제를 제대로 이해하지 못하더라도 너무 초조해하지 말기 바란다. 함

수에 대한 자세한 내용은 9장에서 배우게 될 것이다. 일단 함수가 복잡한 시스템을

만들때매우큰도움이될것이라는점만기억해두자. 함수를이용하면코드와패

키지를손쉽게재사용할수있기때문에실질적으로만들수있는프로그램의범위

를크게넓힐수있다.
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trace() 액션과 마찬가지로 함수에서도 인자를 받아들인다는 점에 유의하자.

area(4, 5);와 같이 함수를호출하는것은 trace (x);와 같이 trace() 명령을 호출하

는 것과 거의 똑같다. 이러한 유사성은 우연이 아니다. 앞에서 지적한 것처럼

trace() 액션을 포함한 적지않은액션이사실함수이다. 하지만 그 함수들은 (우리

가만든 area() 함수와같은사용자정의함수와달리) 액션스크립트에내장된특별한

유형의 함수이다. 따라서‘gotoAndStop() 함수를 호출하라’라는 표현이

‘gotoAndStop 액션을 실행하라’보다 더 합리적이고 정확하다. 내장 함수는 단지

편의상 액션스크립트에 포함되어 있는 재사용할 수 있는 코드 블록이다. 내장 함수

를이용하면수학적인계산에서무비클립제어에이르는다양한작업을처리할수

있다. 모든 내장함수는‘3부. 레퍼런스’에정리해놓았다. 또한 액션스크립트의기

초를배우다보면많은내장함수를접하게될것이다.

무비 클립 인스턴스

지금까지 프로그래밍의 기본 사항에 대해 알아보았는데 그 과정에서 플래시의

기초를 잊어버리지 않았으면 한다. 플래시의 비주얼 프로그래밍의 핵심 중 하나로

무비클립인스턴스(instance)가 있다. 플래시디자이너또는개발자라면무비클립

이그다지낯설지않을것이다. 하지만무비클립을프로그래밍도구라고여기면안

된다.

모든 무비 클립은 플래시 무비의 라이브러리에 있는 심벌 정의를 포함하고 있

다. 라이브러리에서 스테이지로 클립을 끌어서 놓는 방식으로 하나의 플래시 무비

에 하나의 무비 클립 심벌에 대한 여러 개의 복사본 또는 인스턴스를 추가할 수 있

다. 고급플래시프로그래밍에서는무비클립인스턴스를제어하는문제가꽤큰비

중을차지한다. 예를들어반사되는공프로그램은무비클립인스턴스의위치를스

테이지에서계속해서바꿔주는프로그램이라고볼수있다. 인스턴스의위치, 크기,

현재 프레임, 회전과 같은 요소는 무비를 재생할 때 액션스크립트를 이용하여 변경

할수있다.

무비클립과인스턴스에대해익숙하지않다면플래시문서나도움말파일을읽

은후에이책을계속보는것이좋다.
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이벤트 기반 실행 모델

액션스크립트의 기초를 훑어볼 때 마지막으로 살펴보아야 할 주제는 무비에 있

는 코드가 실행되는 시기를 결정하는 실행 모델이다. 무비에서 다양한 프레임, 버

튼, 무비 클립에코드를추가하는경우가많이있다. 하지만그러한코드가언제실

행될까? 이궁금증을해결하기위해컴퓨터의역사에대해잠시알아보도록하자.

컴퓨터가 나온 초기에는 프로그램의 명령어가 첫 줄부터 마지막 줄까지 입력된

순서대로 실행되었다. 프로그램은 어떤 작업을 수행하고 나서 멈추는 것을 의미하

였다. 그러한 종류의 프로그램을 배치(batch) 프로그램이라고 부르며, 플래시같이

이벤트를기반으로하는프로그래밍에서요구되는상호작용을처리할수는없다.

이벤트 기반 프로그램은 배치 프로그램과 같이 순서대로 실행되지 않는다(이벤

트순환문에서). 연속적으로실행되면서어떤일(이벤트)이 일어나는지감시하고그

러한 이벤트에 따라 코드 세그먼트를 실행한다. 시각적인 상호작용 환경에서 사용

하기 위해 만든 언어(액션스크립트나 자바스크립트)에서는 보통 사용자가 마우스를

클릭하거나키보드의키를누르는것과같은행동이이벤트가된다.

마우스 클릭과 같은 이벤트가 발생하면 인터프리터에서는 경고를 내보낸다. 그

리고 나면 프로그램에서는 인터프리터에 적절한 코드 세그먼트를 실행하라고 요구

함으로써 그러한 경고에 반응한다. 예를 들어 사용자가 무비에서 버튼을 클릭하면

무비의다른섹션을보여주는코드를실행하거나(네비게이션) 데이터베이스에변수

를제공(폼보내기)하는것과같은작업을처리할수있다.

하지만 사용자가 이벤트 핸들러를 만들지 않으면 프로그램에서 이벤트에 따른

작업을할수없다. 이벤트핸들러는일반적으로다음과같은형태로만든다.

만약 (이러한 이벤트가 발생하면) {

이러한 코드를 실행한다
}

위와같은내용을보통다음과같은일반적인형태로쓸수있다.

on (이이벤벤트트) {

선선언언문문
}
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예를들어플레이헤드를 200번프레임으로옮기는버튼에대한이벤트핸들러는

다음과같이만들수있다.

on (press) {

gotoAndStop(200);

}

이벤트 기반 프로그램은 언제나 이벤트 순환문을 실행하면서 다음 이벤트에 반

응할 태세를 갖추고 있기 때문에 살아있는 시스템과 비슷하다. 이벤트는 플래시 무

비에서 매우 핵심적인 부분이다. 이벤트가 없다면 플레이헤드가 어떤 프레임에 들

어갔을 때 그 프레임의 코드를 실행하는 것 외에는 스크립트로 할 수 있는 일이 전

혀 없다. 이 경우에는 플레이헤드가 특정 프레임에 들어가는 일이 결국은 이벤트에

해당하는데, 이러한작업의경우에는이벤트핸들러를따로지정할필요가없다.

액션스크립트를 배우는 첫날부터 이벤트를 배우는 이유는 이벤트가 말 그대로

어떤일이일어나게하는역할을하기때문이다. 지금까지스크립트를만드는방법,

스크립트가 실행되는 시기를 결정하는 방법(즉 이벤트)에 대해 배웠다. 이제 첫 실

전예제를만들어볼준비가된셈이다.

퀴즈 프로그램 만들기
지금까지 액션스크립트의 기본 원리를 대강 알아보았으니 이제 이러한 원리를

실제 플래시 무비에 적용해 보자. 지금까지 배운 간단한 프로그래밍 기법을 이용하

여 객관식 퀴즈를 만들어 보는 것으로 플래시 프로그래밍 공부를 시작해 보자. 2장

이후에서도 고급 프로그래밍 개념을 배우고 나서 이 퀴즈 프로그램을 더 향상시킬

수있는방법을찾아볼것이다. 결국에는코드를더고급스럽게만들어확장및관리

가 용이하며 퀴즈에 새로운 기능을 추가해서 임의의 개수 문제를 처리할 수 있도록

만들것이다.

이 퀴즈의 .fla 파일은 온라인 코드 창고에서 구할 수 있다. 여기서는 플래시 프

로그래밍에 대해 배우는 것이지 플래시를 만드는 것에 대해 배우지는 않는다는 점

을명심해두자. 독자들이이미버튼을만들고사용하는법, 레이어, 프레임, 키프레

임 및 텍스트 도구에 익숙하다는 것을 가정하고 설명하겠다. 이 퀴즈에서는 액션스

크립트프로그래밍의다음과같은요소에대한실전응용법을알아보겠다.
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䤎 변수

䤎 함수를이용한플레이헤드제어

䤎 버튼이벤트핸들러

䤎 간단한조건문

䤎 정보를화면에보여주기위한텍스트필드변수

퀴즈 개요

우리가 만들 퀴즈의 일부가 [그림 1-4]에 나와 있다. 이 퀴즈에는 문제가 두 개

밖에 없다. 각 문제에서는 세 개의 답 중에서 한 개의 답을 선택할 수 있다. 사용자

가 답을 제출할 때는 원하는 답에 해당하는 버튼을 클릭하면 된다. 이렇게 선택한

값은변수에저장되어나중에사용자의점수를매기는데쓰인다. 모든문제를답하

고나면정답의개수를계산하고점수를화면에표시한다.
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레이어 구조 만들기

플래시무비를만들때는서로다른컨텐츠요소를별도의레이어에보관하여전

체컨텐츠를관리하기편하도록분리해서정리해야한다. 컨텐츠를레이어로나누는

것이 일반적으로 좋은 방법이기도 하지만 플래시 프로그래밍에서는 반드시 그렇게

해야 한다. 우리가 만드는 퀴즈를 포함하여 대부분의 스크립트를 이용해서 만든 무

비에서는 모든 타임라인 스크립트를 scripts라는 독립된 레이어에 보관한다. 필자는

scripts 레이어를레이어스택의맨위에오도록해서언제나찾기쉽도록해놓는다.

그리고모든프레임레이블을 labels라는별도의레이어에관리한다. labels 레이

어는 모든 타임라인에서 scripts 레이어 바로 밑에 둔다. 이 두 개의 표준 레이어

(scripts와 labels) 외에도 퀴즈 무비에서는 다양한 컨텐츠를 분리하기 위해 일련의

컨텐츠레이어를이용한다.

퀴즈를 만들 때 가장 먼저 할 일은 새로운 레이어를 만들고 아래와 같은 이름을

붙인다음, 여기나온순서대로정렬하는것이다.

scripts

labels

quiz end

question 2

question 1

housing

이제각레이어에 30개의프레임을추가한다. 그러면 [그림 1-5] 같은모양의타

임라인이만들어진다.
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[그림 1-5] 퀴즈 타임라인 초기 설정



인터페이스와 문제 만들기

퀴즈를 실행시키는 스크립트를 만들기 전에 사용자가 퀴즈를 풀어나가는 데 사

용할문제와인터페이스를설정해야한다.

다음단계를따라하면된다.

1. housing 레이어를 선택하고 프레임 1에서 텍스트 도구를 이용하여 스테이

지에직접타이틀을입력한다.

2. question 1 레이어의프레임 1에서문제번호‘1’과문제 1에해당하는텍스

트를입력한다. “When were movie clips introduced into Flash?”이때문

제밑에답과버튼을추가할공간을남겨둔다.

3. 텍스트한줄높이보다크지않은체크박스나라디오버튼모양의간단한버

튼을만든다.

4. question 1 레이어에서 문제 밑에 세 개의 답을 입력한다. ‘Version 1’,

‘Version 2’, ‘Version 3’을각각다른줄에입력한다.

5. 각답옆에체크박스버튼의인스턴스를추가한다.

6. 문제 2를만들때는문제 1을템플릿으로사용한다. question 1 레이어의첫

째프레임을선택하고 Edit → Copy Frames를선택한다.

7. question 2 레이어의 10번 프레임을 선택하고 Edit → Paste Frames를 선택

한다. 그러면 첫째 문제의 복사본이 question 2 레이어의 10번 프레임에 복

사된다.

8. question 2 레이어의 10번 프레임에서 문제 번호를 1에서 2로 고치고 문제

텍스트를“When was MP3 audio support added to Flash?”로, 답을

‘Version 3’, ‘Version 4’, ‘Version 5’로고친다.

9. 마지막으로문제 1이문제 2 밑에나오는것을막기위해 question 1 레이어

의 10번프레임에비어있는키프레임을추가한다.

[그림 1-6]에는퀴즈에첫째문제를추가했을때의플래시무비가, [그림 1-7]에

는퀴즈에두개의문제를입력했을때의타임라인이나와있다.
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퀴즈 초기화

거의모든스크립트에서마찬가지지만퀴즈스크립트에서가장먼저할일은무

비전반에걸쳐사용할메인타임라인변수를만드는일이다. 지금만드는퀴즈에서

는무비의첫째프레임에서이작업을하지만다른무비에서는보통무비의일부또

는전체를미리읽어들인후에이작업을처리한다. 어떤방법을사용하든지다른스

크립트를 시작하기 전에 변수를 초기화해야 한다. 변수가 정의된 후에는 stop() 함

수를호출하여첫째프레임(퀴즈가시작하는지점)에서무비가멈출수있도록한다.

더 복잡한무비에서는무비의나머지부분을미리준비해두기위해함수를호출

하거나변수값을대입하여초기조건을설정하는경우도있다. 이러한단계를보통

‘초기화(initialization)’라고 부른다. 움직이는 과정을 시작하거나 시스템이 동작되

는초기조건을정의하는함수에는보통 init이라는이름을붙인다.
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[그림 1-6] 퀴즈 제목과 문제 1

[그림 1-7] 두 개의 문제를 입력했을 때의 타임라인



우리가만드는퀴즈의 init 코드는 [예제 1-1]에 나와있으며무비의 scripts 레이

어의 1번프레임에들어간다.

[예제 1-1] 퀴즈의 init 코드

// 메인 타임라인 변수 초기화
var q1answer;      // 문제 1에 대한 사용자의 답변
var q2answer;        // 문제 2에 대한 사용자의 답변
var totalCorrect = 0; // 정답 개수
var displayTotal;    // 사용자의 점수를 표시하기 위한 텍스트 필드

// 첫 번째 질문에서 무비를 정지시킴
stop();

init의첫줄은코드주석(code comment)이다. 코드 주석은간단한설명을덧붙

이는데쓰인다. 한 줄짜리주석은두개의슬래시를연속해서쓴다음공백을추가

하는것으로시작된다. 그리고나서그뒤에필요한내용을입력한다.

// 이 부분은 주석입니다.

다음과같이주석을코드와같은줄에넣어도상관없다.

x = 5; // 이것도 주석입니다.

[예제 1-1]의 둘째 줄에서는 q1answer라는 변수를 만든다. 변수를 만들 때는

var라는키워드뒤에변수이름을적는다는것을다시떠올려보자.

var favoriteColor;

둘째줄부터다섯째줄까지는앞으로사용할변수를선언하는부분이며각변수

의사용목적을주석으로적어놓았다.

䤎 q1answer와 q2answer에는 사용자의 답변(사용자가 1, 2 또는 3 중에서 고

른 값)이 저장된다. 이 값을 이용하여 사용자가 정답을 선택하는지 결정하

게된다.

䤎 totalCorrect는퀴즈의끝부분에서정답의개수를세는데쓰인다.

䤎 displayTotal은 totalCorrect의값을화면에출력할때사용할텍스트필드의

이름이다.
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[예제 1-1]의넷째줄을자세히살펴보자.

var totalCorrect = 0;  // 정답 개수

여기서는 두 가지 작업을 처리한다. 우선 totalCorrect라는 변수를 선언하고 대

입 연산자인 등호(=)를 이용하여 그 변수에 0을 대입한다. 사용자가 한 문제도 제

대로 맞추지 못했을 때를 대비하여 totalCorrect의 기본값을 0으로 설정한다. 다른

변수는퀴즈가진행되면서직접값을대입하도록되어있으므로초기값을설정하지

않아도된다.

변수를정의한다음에는 stop() 함수를호출하여퀴즈가시작되는 1번프레임에

서무비를정지시킨다.

// 첫 번째 질문에서 무비를 정지시킴
stop();

stop() 함수는 플래시 4 이전 버전에서 사용한 stop 액션(플레이헤드를 현재 프

레임에서잠시멈춘다)과똑같은역할을한다.

이제 init 코드에서 어떤 작업을 처리하는지 알았으므로 퀴즈 무비에 이 코드를

추가해보자.

1. scripts 레이어의 1번프레임을선택한다.

2. Window → Actions를선택하면 Frame Actions 패널이나타난다.

3. 전문가 모드(Expert mode)에서 사용 중인지 확인한다. Edit → Preferences

에서영구적으로설정할수있다.

4. Frame Actions 패널의오른쪽에[예제 1-1]에나온대로 init 코드를입력한다.
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stop() 함수를 호출하는 부분 위에 있는 주석을 살펴보자. 이 주석에서는 그 아래에 있는 코드
를 작성한 이유를 설명한다. 주석은 필수적인 것은 아니지만 한동안 작업을 하지 않다가 다시
작업할 때, 또는 다른 사람에게 코드를 넘겨줄 때 코드를 이해하는 데 도움이 된다. 또한 주석
이 있으면 코드를 훑어보기 편해지는데, 디버깅할 때 큰 도움이 된다.



프레임 레이블 추가하기

퀴즈의 init 스크립트 및 문제 부분을 만들었다. 이제 퀴즈 재생을 제어할 수 있

도록프레임레이블을추가해야한다.

사용자가한번에한문제씩풀수있도록하기위해문제 1과문제 2의내용을 1

번 프레임과 10번 프레임으로 갈라놓았다. 플레이헤드를 그 키프레임으로 옮겨서

각 슬라이드에 하나씩 문제가 들어가는 슬라이드쇼 효과를 만들자. 문제 2가 10번
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변수 명명법

지금까지 적지 않은 변수를 접해봤는데, 대소문자를 섞어 쓰는 것에 대해 궁금해하는

독자들도 있을 것이다. 프로그래밍 경험이 전혀 없는 독자라면 firstName이나

totalCorrect에서처럼 단어 중간에 대문자가 들어 있는 것이 조금 이상하게 느껴질지도

모른다. 변수 이름에서 두 번째 이후에 오는 단어를 대문자로 적으면 단어를 구분하기

편하다. 이런 방법을 쓰는 것은 스페이스나 대시를 변수 이름에 사용할 수 없기 때문이

다. 하지만 변수 이름의 첫 글자는 대문자로 쓰면 안 된다. 대문자로 시작하는 이름은

변수이름이아니라객체클래스이름으로쓰이기때문이다.

first_name이나 total_correct와 같은 식으로 대문자 대신 밑줄(_)을 이용하는 것을 선호

한다면 일관되게 그러한 방식을 사용하는 것이 좋다. firstName 같은 형식과

second_name 같은 형식을 섞어 쓰는 것은 좋지 않다. 자신이 만든 코드를 다른 프로그

래머가 쉽게 읽을 수 있도록 하려면 둘 중 한 가지 방법만 선택하여 사용하자. 언어에

따라변수이름의대소문자를구분하는경우가있기때문에 firstName과 firstname은서

로 다른 변수로 쓰이는 경우도 있다. 하지만 액션스크립트에서는 대소문자를 구분하지

않는다. 그렇다고 해서 같은 변수를 대소문자 구분 없이 아무렇게나 표기하는 것은 매

우 안 좋은 방법이다. 예를 들어 어떤 변수를 xPOS라고 쓰기로 했다면 다른 곳에서

xpos라고쓰는것은피해야한다.

변수나 함수 이름은 항상 그 변수나 함수의 의미를 쉽게 이해할 수 있도록 만드는 것이

좋다. ‘foo’와 같이 아무 쓸모 없는 이름은 사용하지 않는 편이 낫고, ‘x’, ‘i’와 같이

한 글자로 된 변수명은 루프의 인덱스(숫자를 세는 데 쓰는 변수)와 같이 간단한 경우에

만사용하도록하자.



프레임에 있으므로 문제 2를 화면에 표시하려면 다음과 같이 gotoAndStop() 함수

를호출하면된다.

gotoAndStop(10);

이렇게 하면 플레이헤드가 문제 2가 있는 10번 프레임으로 움직인다. 참 잘 만

든 코드처럼 보인다. 하지만 잘 생각해 보면 그렇지 않다는 것을 알 수 있다.

gotoAndStop() 함수를호출할때 10이라는숫자를써도여기서는제대로동작하긴

하지만그다지확장성이좋지는않다. 예를들어 10번프레임앞에있는타임라인에

다섯 개의 프레임을 새로 집어넣는다면 문제 2의 프레임 번호가 15번으로 갑자기

바뀌게 되므로 gotoAndStop(10) 이라는 명령어를 내리면 엉뚱한 프레임으로 이동

하게 된다. 프레임이 타임라인에서 움직이더라도 코드가 제대로 작동하도록 하고

싶다면프레임번호대신프레임레이블(frame label)을 사용한다. 프레임레이블은

q2나 quizEnd와 같이 타임라인의 특정 위치를 표시하기 위한 이름이다. 위치의 레

이블을만들고나면숫자대신이름을이용하여그프레임을찾아낼수있다.

프레임 레이블이 없으면 프로그래밍이 거의 불가능해진다. 필자는 gotoAnd

Stop()과같은재생제어함수에서프레임번호를사용하는일이거의없다. 퀴즈에

필요한 모든 프레임에 레이블을 붙여서 나중에 퀴즈 문제를 이동하는 데 사용하도

록하자.

1. labels 레이어에서 1번프레임을클릭한다.

2. Modify → Frame을선택하면 Frame 패널이화면에나타난다.

3. Label 텍스트필드에 init이라고입력한다.

4. labels 레이어의 10번프레임에아무내용이없는키프레임을추가한다.

5. Frame 패널의 Label 텍스트필드에 q2라고입력한다.

6. labels 레이어의 20번프레임에아무내용이없는키프레임을추가한다.

7. Frame 패널의 Label 텍스트필드에 quizEnd라고입력한다.
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답변 버튼 스크립트 만들기

지금까지문제를만들고변수를초기화하고프레임레이블도붙여보았다. 무비

를지금테스트한다면, 문제 1과세개의답변버튼이나타나긴하지만버튼을눌렀

을때아무런응답도없을것이고문제 2로넘어갈수도없게된다. 따라서 답변버

튼에어떤코드를추가하여한문제에응답하면다음문제가나오는식으로만들어

야한다.

편의상 [그림 1-8]에 나온것과같이답변버튼을각각버튼 1, 버튼 2, 버튼 3으

로부르기로하자.

세개의버튼에는거의비슷한스크립트가들어간다. [예제 1-2]에서 [예제 1-4]

까지의내용은각버튼에해당하는코드이다.

[예제 1-2] 문제 1, 버튼 1의 코드

on (release) {

q1answer = 1;

gotoAndStop ("q2");

}

[예제 1-3] 문제 1, 버튼 2의 코드

on (release) {

q1answer = 2;

gotoAndStop ("q2");

}
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[그림 1-8] 답변 버튼

버튼 1

버튼 2

버튼 3



[예제 1-4] 문제 1, 버튼 3의 코드

on (release) {

q1answer = 3;

gotoAndStop ("q2");

}

이 버튼 코드는 두 개의 선언문(둘째, 셋째 줄)으로 이루어지며, 이 코드는 마우

스클릭이 감지되었을 때만 동작한다. 사람들이 쓰는 말로 표현하자면 각 버튼에 해

당하는코드는‘사용자가버튼을클릭하면사용자가 1, 2, 3 중에어떤답을골랐는

지기록한후에문제 2로가라’라고쓸수있다. 자세한동작과정을설명하면다음

과같다.

첫째줄은이벤트핸들러를시작하는부분이다.

on (release) {

이벤트핸들러에서는사용자가버튼 1을클릭할때까지끈기있게기다린다. 이

벤트 핸들러는 무비가 실행되는 동안에 어떤 일(마우스 클릭 같은 일)이 일어날 때

까지 기다린다는 것을 상기하자. 이벤트가 발생하면 적절한 핸들러에 있는 코드가

실행된다.

첫째줄로시작하는이벤트핸들러를자세히살펴보자. ‘on’이라는키워드는이

벤트핸들러의시작을알린다. 괄호 안에들어있는‘release’라는키워드는이벤트

핸들러에서 기다리고 있는 이벤트 유형을 나타낸다. 이 경우에는 사용자가 마우스

버튼을 클릭했다가 버튼에서 손을 떼는‘release’라는 이벤트를 기다린다. 왼쪽 중

괄호({)는 release 이벤트가 발생했을 때 실행할 선언문 블록의 시작을 나타낸다.

코드 블록을 끝내는 넷째 줄에서는 오른쪽 중괄호(})를 이용하여 이벤트 핸들러가

끝남을나타낸다.

둘째 줄은 release 이벤트가발생했을때실행되는첫선언문이다. 둘째 줄에있

는코드는이제독자들에게도익숙할것이다.

q1answer = 1;

여기서는 q1answer라는 변수를 1로 설정한다(다른 답변 버튼에서는 그 변수를

각각 2나 3으로 설정한다). q1answer 변수에는 첫째 문제에 대한 사용자의 답변이
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저장된다. 답변을저장하고나면버튼코드의셋째줄에있는코드를통해문제 2로

넘어간다.

gotoAndStop ("q2");

셋째줄에서는 gotoAndStop() 함수를호출하는데, 이 때‘q2’레이블을인자로

넘겨서플레이헤드를문제 2가시작되는 q2라는프레임으로움직인다.

이제 버튼코드가작동하는원리를이해했으면이코드를문제 1의버튼에추가

해보자.

1. Actions 패널이 열린 상태에서 스테이지에 있는 버튼 1을 선택한다. Frame

Actions라는 타이틀이 Object Actions로 바뀐다. 지금부터 입력하는 코드는

모두버튼 1(스테이지에서선택한객체)로들어간다.

2. Actions 패널의오른쪽에 [예제 1-2]에있는코드를입력한다.

3. 1, 2 단계를 반복하여 버튼 2와 버튼 3에 코드를 추가한다. [예제 1-3]과

[예제 1-4]에 나온것처럼버튼 2에서는 q1answer를 2로, 버튼 3에서는 3으

로설정한다.

문제 2 버튼의 코드도 결국은 문제 1 버튼의 코드와 똑같다(답변 변수의 이름과

gotoAndStop()을 호출할 때 쓰이는 인자가 바뀔 뿐이다). 문제 2의 버튼 1에 해당하

는코드는 [예제 1-5]와같다.

[예제 1-5] 문제 2, 버튼 1의 코드

on (release) {

q2answer = 1;

gotoAndStop ("quizEnd");

}

사용자가 문제 2에서 선택한 답을 기록해야 하기 때문에 q1answer 대신

q2answer를 이용한다. 또한 문제 2를 마친 후에 플레이헤드를 퀴즈의 끝(quizEnd

라는 레이블이 붙은 프레임)으로 보내려면 gotoAndStop() 함수를 호출할 때

‘quizEnd’라는인자를사용해야한다.

1장. 프로그래밍을 모르는 독자를 위한 기본 소개 63



문제 2에있는버튼에버튼코드를추가하자.

1. question 2 레이어의 10번프레임을클릭한다.

2. 버튼 1을클릭한다.

3. Actions 패널에 [예제 1-5]에나온코드를입력한다.

4. 2, 3 단계를 반복하여 버튼 2와 버튼 3에 코드를 추가한다. 버튼 2에서는

q1answer를 2로, 버튼 3에서는 3으로설정한다.

이제 여섯 개의 버튼에 모두 버튼 코드를 추가하고 나면 코드가 계속 반복된다

는것을깨달았을것이다. 각 버튼에있는코드는서로몇글자씩밖에다르지않다.

이러한 방식은 그다지 효율적이지 않다. 이러한 코드 대신 일괄적으로 답변을 기록

하고 다음 스크린으로 넘어가는 뭔가를 만드는 것이 현명할 것이다. 9장에서 함수

를이용하여이런작업을일괄적으로처리할수있는방법을살펴보자.

퀴즈 마지막 장면 만들기

퀴즈가거의완성되었다. 지금까지사용자가질문에답하면다음문제로넘어갈

수 있도록 해주는 스크립트가 들어 있는 문제를 두 개 만들었다. 이제 사용자의 성

적을알려주는퀴즈의마지막장면을만들어야한다.

퀴즈끝부분을만들려면기본적인플래시를만들고스크립트도짜야한다. 우선

플래시를만들어보자.

1. question 2 레이어의 20번 프레임에 새로운 키프레임을 추가한다. 이렇게

해야퀴즈마지막장면에문제 2가겹쳐서나타나는것을막을수있다.

2. quiz end 레이어의 20번프레임에새로운키프레임을추가한다.

3. 그프레임에서스테이지에다음과같은텍스트를입력한다. “Thank you for

taking the quiz. Your final score is: /2.”점수를 출력하려면‘is:’와‘/2’

사이에빈공간을적당히남겨두어야한다.

4. scripts 레이어의 20번프레임에새로운키프레임을추가한다.
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퀴즈의마지막장면은위와같은단계를거쳐서만들수있다. 이렇게하고나면

[그림 1-9]에나온것과같은마지막장면이만들어진다.

이제 마지막 장면의 스크립트를 만들 차례이다. 플레이헤드가 quizEnd 프레임

으로오면사용자의점수를계산해야한다. 따라서 플레이헤드가 20번프레임에도

착할 때 점수를 계산하기 위한 스크립트가 필요하다. 타임라인의 키프레임에 있는

모든스크립트는플레이헤드가그프레임에도달하는순간에실행되기때문에계산

스크립트는 scripts 레이어의 20번프레임에추가한키프레임에넣으면된다.

계산스크립트에서는우선사용자의점수를결정한다음그점수를화면에표시

한다.

// 사용자의 정답 개수를 센다.

if (q1answer == 3){

totalCorrect = totalCorrect + 1;

}

if (q2answer == 2){

totalCorrect++;

}

// 화면에 있는 텍스트 필드에 사용자의 점수를 표시한다.

displayTotal = totalCorrect;

1장. 프로그래밍을 모르는 독자를 위한 기본 소개 65

[그림 1-9] 성적 공개



첫째 줄과 여덟째 줄은 스크립트를 설명하는 코드 주석이다. 둘째 줄에서 두 조

건문 중 첫 째 조건문이 시작된다. 여기서는 q1answer 변수를 이용하여 다음과 같

은코드를만들었다.

if (q1answer == 3){

if라는키워드는어떤조건이만족될때만실행할선언문의리스트를제공하겠다

는 것을 의미한다. 그 조건은 if 키워드 바로 뒤에 오는 괄호 안에 들어간다

(q1answer == 3). 그리고 왼쪽 중괄호는 조건에 따라 실행되는 선언문이 시작됨

을 알린다. 따라서 둘째 줄은‘q1answer의 값이 3이면 중괄호 안에 있는 선언문을

실행시킨다’라고이해할수있다.

하지만‘q1answer == 3’이라는 조건은 정확하게 어떤 식으로 작동할까? 이

구문을풀어보자. q1answer가문제 1에대한답변을저장해놓은변수라는것은이

미알고있을것이다. 숫자 3은문제 1의정답이다. 무비 클립은플래시 3에서처음

도입되었기 때문이다. 변수와 숫자 3 사이에 있는 두 개의 등호(==)는 양쪽에 있

는 표현식을 비교하는 동치(equality) 비교 연산자이다. 왼쪽에 있는 표현식

(q1answer)과 오른쪽에있는표현식(3)이 같으면이조건이만족되기때문에, 중괄

호안에있는선언문이실행된다. 그렇지않으면조건이만족되지않기때문에중괄

호안에있는선언문을건너뛰게된다.

플래시는 퀴즈 문제의 정답을 알지 못한다. q1answer의 값이 3인지 아닌지를

조사함으로써 사용자가 문제 1의 정답을 맞췄는지 여부를 알아낼 수 있다. 만약 정

답을제대로맞췄다면다음과같이사용자의총점을 1점올려준다.

totalCorrect = totalCorrect + 1;

셋째 줄은‘totalCorrect의원래 값에 1을 더한 새로운 값을 대입하라’라는 것을

의미한다(즉, totalCorrect 값을증가시킨다). 어떤 변수의 값을 1씩증가시키는작업

은꽤자주쓰이기때문에 ++라는연산자가따로지정되어있다.

따라서아래와같이

totalCorrect = totalCorrect + 1;

라고쓰는대신보통다음과같이쓴다.

totalCorrect++;
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이렇게하면같은작업을더간결하게처리할수있다.

넷째줄에서는첫째조건이만족되었을때실행되는선언문블록을끝마친다.

}

다섯째에서일곱째줄까지는다른조건을처리한다.

if (q2answer == 2){

totalCorrect++;

}

여기서는사용자가문제 2의정답(MP3는플래시 4부터지원되었다)을 제대로맞

췄는지조사한다. 사용자가두번째답변을선택했다면증가연산자인 ++를이용하

여 totalCorrect 값을하나증가시킨다.

이퀴즈에는문제가두개밖에없기때문에정답개수를세는작업이끝났다. 사

용자가 정답을 선택한 개수만큼 totalCorrect 값을 증가시켰기 때문에, totalCorrect

에는 사용자의 총점이 저장된 상태이다. 이제 할 일은 사용자에게 점수를 보여주는

것인데, 이 작업은퀴즈마지막장면의스크립트의마지막줄인아홉째줄에서처리

한다.

displayTotal = totalCorrect;

이제 변수에 대해서는 충분히 배웠으니 아홉째 줄에서 displayTotal이라는 변수

에 totalCorrect의 값을 대입한다는 것은 이해할 수 있을 것이다. 하지만 화면에는

어떻게점수를표시할까? 아직까지는화면에점수가표시되지않는다. 점수를화면

에표시하려면화면에직접표시되는텍스트필드(text field) 변수라는특별한종류

의변수를만들어야한다. 이러한변수를직접만들어보자.

1. Text 도구를선택한다.

2. quiz end 레이어에서 20번프레임을선택한다.

3. 미리 만들어둔 텍스트의‘/2’바로 앞에 포인터를 갖다 놓고 스테이지를 클

릭한다.

4. 숫자한개가들어갈 정도의 적당한 크기로마우스를 드래그하여 텍스트박

스크기를조절한다.
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5. Text → Options를선택한다.

6. Text Options 패널에서 Static Text를 Dynamic Text로변경한다.

7. Variable 텍스트필드에 displayTotal을입력한다.

이제 displayTotal 변수를화면에표시할수있다. 스크립트에서 displayTotal 값

을바꾸면그에해당하는텍스트필드변수의내용이화면에갱신된다.

퀴즈 테스트

이제모든작업이끝났다. 퀴즈가완성된것이다. Control → Test Movie를선택

하여 퀴즈가 제대로 되는지 확인해보자. 다양한 답변을 입력해보고 점수가 제대로

나오는지 살펴보자. 새로운 버튼을 만들어서 그 버튼에 다음과 같은 코드를 집어넣

으면무비를다시재생시킬수도있다.

on (release) {

gotoAndStop("init");

}

totalCorrect 값을 0으로 설정하는 부분이 init 프레임에 있기 때문에, 매번 플레

이헤드가 init으로움직일때마다그값은 0으로다시설정된다.

퀴즈가제대로작동하지않는다면온라인코드창고에있는샘플퀴즈와비교해

보기바란다. 또한‘19장. 디버깅’에서배우게될문제해결기법을이용해도좋다.

앞으로 배울 내용
자, 1장을마치고나니기분이어떤가? 지금까지 구문도여러개배우고문법과

단어도 조금 배웠으며, 플래시와 간단한 대화(퀴즈 프로그램)도 나누어 보았다. 이

정도면첫날치고는많이배운셈이다.

독자들도이미알고있겠지만액션스크립트에대해배울내용이아직도많이남

아 있다. 하지만 내용을 조금만 알아도 꽤 많은 작업을 할 수 있다. 지금까지 배운
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것만으로도 이것저것 장난칠 만한 일들이 많을 것이다. 이 책의 나머지 부분에서는

지금까지대략훑어본내용들을더깊이배우고실전예제를통해직접사용해봄으

로써액션스크립트에대한지식을더욱튼튼하게할것이다. 물론지금까지전혀소

개하지않은주제도다룰것이다.

의사소통, 협동을염두에두고분명하게자신의뜻을표현해야한다는점을기억해

두자. 그리고뭔가멋진것을만들고그것을다른사람들과함께나누고싶다면 http://

www.moock.org/webdesign/flash/contact.html로필자에게보내주기바란다.

이제 실용적인 내용은 어느 정도 익혔으므로 앞으로 몇 장에 걸쳐 자세한 기본

지식을 배워보도록 하자. 이 과정을 마치고 나면 액션스크립트를 더 깊이 이해하여

좀더복잡한무비도만들수있게될것이다.
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